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What is ImageView?
ImageView is an image viewer for Windows.    ImageView enables you to view high quality image files 
that you retrieve from the Internet.    ImageView is a very sophisticated image viewer; you can view, 
change, print, save, and convert images with ImageView.    ImageView features many advanced 
configuration options. 

ImageView can load/save image files in: JPEG JFIF, GIF 87a/89a, Truevision TARGA, Windows and OS/2 
BMP.    ImageView can perform batch compression, batch printing, contact sheet image merging and 
slideshow viewing.

Image editions include: Cropping, Resizing, Rotating, RGB, Contrast, HSV, YCrCb, Gamma, conversion 
to Grayscale, photo Negative, Interactive RGB editing with algebraic function mapping definitions, 
individual palette entry edition, smoothing filter, adding text and full support for cutting and pasting image 
pieces. ImageView supports 24 bit images and 8 bit images, providing a configurable quantizer for up to 2 
passes.    Floyd-Steinberg Dithering is also supported.

Windows drag-and-drop, file name extension association and printing are also supported.

ImageView is compatible with WECJLIB.DLL, a fast Jpeg decompression library from Express 
Compression Laboratories.

This software needs a 386 or better CPU to run.    A true color SVGA card is also recomended, though the 
software will run under on most cards. A mouse is required for some functions.



Starting ImageView
Although ImageView is set up to be used automatically in several AIR Series applications, you can also 
run it as a stand-alone application.

Start ImageView by clicking the ImageView icon. The ImageView application is displayed. 

An image can be opened by choosing Open from the File menu, and specifying the path and filename for 
the file you want to view.

ImageView has many menu commands that allow you to perform commands and set ImageView options. 

____
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File Menu 

Edit Menu 

Options Menu 

Retouch Menu 

Options Menu 



File Menu
In the File menu you will find commands to open/save/print an image file, possibly converting its format.    
The File menu commands are listed below.

New 

Open 

Save 

Save As 

Delete 

Exit 



New 
This command will allow you to create an empty image for edition. You will be asked for the new image 
dimensions, and ImageView will paint it with the current background color. You can construct an image 
from pasting pieces of other images from the clipboard and adding text to it.



Open
This command will open a dialog window to specify the file name and directory for the image to be 
loaded. Loading attributes comply with the current setup. See the Options menu commands for 
information.



Save
This command saves the displayed image using the original file name. Attributes comply with the current 
setup. See the Options menu commands for information.



Save as 
This command will open a dialog window to specify the new file name to which the image is to be saved. 
Image saving attributes comply with the current setup. See the Options menu commands for information.



Delete
This command will delete the last filename successfully opened or saved. You will be prompted for a 
confirmation, before deletion takes place.



Print 
This command will print the image being displayed. Before printing, the user will be presented with a 
dialog for configuring printer options.



Printer setup 
This command will open a dialog for configuring system dependent printer characteristics.



Exit 
This command will end ImageView. If an image is being loaded or saved when you select this command, 
ImageView will prompt you for a confirmation before exiting. If the image has been changed, ImageView 
will offer you to save it before exiting.



Edit Menu
In the Edit menu you will find commands to access the clipboard, change image size and position. All 
commands in this menu will operate restricted to the current selected area, if any.    The Edit menu 
commands are listed below.

Cut 

Copy 

Paste 

Delete 

Resize 

Redimension 

Crop 

Apply 

Undefine 

Add Text 

Flip Horizontal 

Flip Vertical 

Rotate Left 

Rotate Right 



Cut 
Transfers the current image to the clipboard, and erases it from ImageView's window. This command is 
useful when Windows is low in memory. If you want to copy the image to the clipboard and retain it in 
ImageView, use the Copy command.

If you select this option after defining a selection area on the image, ImageView will copy only this 
selected area to the clipboard.



Copy 
Copies the current image to the clipboard. This command does not erase the image from ImageView's 
window. If Windows is low in memory, try the Cut command.

If you select this option after defining a selection area on the image, ImageView will copy only the 
selected area to the clipboard.



Paste 
Copies an image from the clipboard to ImageView's window. If ImageView is already an image, the 
clipboard image will be pasted to a detached selection area and placed in the upper left corner of the 
image, ready to be moved or applied.

If the user defines a selection area prior to pasting, the clipboard image will be resized to fit that area, and 
pasted over it.



Delete (Image)
Deletes the image from ImageView's window. This is useful to free memory without exiting ImageView. If 
the user defines a selection area, only that area will be deleted.



Resize 
Resizes the image to a new width and height.

You will set the new width and height in a dialog, where you can choose from a few predefined 
dimensions or define custom values for width and height. The "Fit to desktop" option will resize the image 
to the maximum dimensions the current graphics mode can exhibit without using scrollbars.

In the Resize dialog, keeping the "Preserve aspect ratio" box checked will make ImageView recalculate 
the specified    width or height to preserve the image aspect ratio. The image's new width and height will 
not exceed the ones you choose. This will work for the predefined dimensions as well.

If a selection area is defined, resizing will act on it.



Redimension
Redimensions the image to a new width and height.

This command is similar to the Resize command, except that the image is not "Resized" to the new 
dimensions; rather, the image area becomes changed. The image will be cropped or extended to the new 
dimensions, without being resized.

If a selection area is defined, redimensioning will act on it.



Crop
Crops the image to the current selection area.

Cropping images is especially useful before converting GIF files to JPEG format. Always crop the border 
around the image, to improve both compression quality and ratio.



Apply
Tiles the detached selection area to its current position. This may be useful when it's difficult or impossible 
to click the mouse outside the selection area.

See the Selection Area Procedures section for more information.



Undefine
Undefines either a DEFINED or a DETACHED selection area. This may be useful when it's difficult or 
impossible to click the mouse outside the selection area (for DEFINED areas), same effect as Edit/Delete 
for DETACHED areas.

See the Selection Area Procedures section for more information.



Add Text
This command opens a dialog window where you can define a string of text to be added to the editing 
image. Text is always added to a detached selection area, that can be moved, applied or deleted after the 
closing of this dialog. If no area is defined, this command will create a default selection area in the upper 
left corner of the editing image. In the dialog you can define many characteristics for the text to be added, 
such as color, background color, orientation, positioning, font, and if the background should be opaque or 
transparent. You can also move and resize the selected area while defining the text to be added, by 
clicking on the small arrows in the dialog's window. The arrows can compress, expand or move the 
selection area in the four directions (up, down, left and right).



Flip Horizontal
Flips (mirrors) the image horizontally. If a selection area is defined, only that area will be flipped.



Flip Vertical
Flips (mirrors) the image vertically. If a selection area is defined, only that area will be flipped.



Rotate Left
Rotates the image counter clockwise, transforming rows into columns and vice-versa. If a selection area 
is defined, only that area will be rotated.



Rotate Right
Rotates the image clockwise, transforming rows into columns and vice-versa. If a selection area is 
defined, only that area will be rotated.



Retouch Menu
In the Retouch menu you will find commands to edit the image in terms of different graphical image 
representations.    The Retouch menu commands are listed below.

GrayScale 

Negative 

HSV Adjust 

YCbCrAdjust 

Color Balance 

Contrast Enhance 

Gamma Correction 

Interactive RGB 

Palette Entry 

Smooth Filter 



GrayScale
This command will transform the image being displayed to Grayscale representation. The user will be 
asked to confirm the selection, before the image is changed.



Negative
This command will make a "photographic negative" from the image being displayed. The user will be 
asked to confirm the selection, before the image is changed.



HSV Adjust 
This command will open a dialog window with scrollbars to edit HSV values for the image displayed. 
Moving the scrollbars will change each attribute. Lower/Upper values will Decrease/Increase the global 
amount of (H)ue, (S)aturation and (V)alue for the image.

During a display/edit session of an 8-bit image, moving the scrollbars will automatically alter the image. 
For 24-bit images, you will have to set a new value for each component, and then click on the "EXEC" 
button for the changes to take effect. As HSV editing is slower (but still feasible) for 24-bit images, making 
all the desired changes in one pass will cut down editing time.

All changes are performed on the original image. If you are satisfied with an HSV setting, click on the 
"UPDT" button, and the original images are updated to the current editing setting. If after further editing 
you click on the "CANCEL" button, you will exit the dialog, and the image will be reset to the last update 
saved. Click on "OK" to update the image to the current setting and exit the dialog.

Prop Sat/Prop Val

These are two check boxes in the HSV dialog. When checked, they will make ImageView alter Saturation 
and Value attributes "proportionally." In short, this means that when you increase Saturation or Value 
attributes for the image, pixels low on the edited attribute will be more increased than pixels high on it. 
Conversely, when you decrease the attribute value for the image, pixels high on the attribute will be more 
decreased than pictures low on it. If you uncheck these boxes, Saturation/Value offsets apply equally to 
all pixels. Checking is useful, for instance, to brighten up the darker pixels of an image without making its 
brighter pixels too bright. Note that extremely dark pixels may not brighten up consistently.



YCbCr Adjust
This command will open a dialog window with scrollbars to edit Y, Cb and Cr values for the image 
displayed. Moving the scrollbars will change each attribute. Lower/Upper values will Decrease/Increase 
the global amount of Y, Cb and CR pixel components.

During a display/edit session of an 8-bit image, moving the scrollbars will automatically alter the image. 
For 24-bit images, you will have to set a new value for each component, and then click on the "EXEC" 
button for the changes to take effect. As YCbCr editing is slower (but still feasible) for 24-bit images, 
making all the desired changes in one pass will cut down editing time.

All changes are performed on the original image. If you are satisfied with an YCbCr setting, click on the 
"UPDT" button, and the original images are updated to the current editing setting. If after further editing 
you click on the "CANCEL" button, you will exit the dialog, and the image will be reset to the last update 
saved. Click on "OK" to update the image to the current setting and exit the dialog.



Color Balance
This command will open a dialog window to edit the Red, Green and Blue attributes of the image. 
Increasing/Decreasing any of these attributes will increase/decrease the corresponding value for each 
pixel on the image. If you are viewing a 24-bit image, set new offset values for Red, Green and Blue and 
then press the "Exec" button to execute your choices. On a 256 color display, editions will be executed as 
soon as they are defined.



Contrast Enhance
This command will open a dialog for the image. Increasing/Decreasing the Contrast value will 
increase/decrease the image's Contrast.



Gamma Correction
This command will open a dialog window to edit the gamma (brightness) value for the Red, Green and 
Blue attributes of the image. Increasing/Decreasing any of these attributes will increase/decrease the 
corresponding gamma value for each pixel on the image. Selecting "Lock RGB" will make ImageView 
apply the same gamma to Red, Green and Blue components. Unchecking "Lock RGB" will allow for 
individual gamma settings for Red, Green and Blue. If you are viewing a 24-bit image, and "Lock RGB" is 
not selected, set new gamma values for Red, Green and Blue and then press the "Exec" button to 
execute your choices. On a 256 color display, or if "Lock RGB" is unchecked, editions will be executed as 
soon as they are defined.



Interactive RGB
This command will open a dialog window for interactive RGB editing.

The user will define the mapping for Red, Green and Blue transformations, either by "drawing" a curve on 
the mapping display, or by defining a Function (see Calculator for details on building function 
expressions).

Checking "Lock RGB" makes ImageView utilize the same mapping for Red, Green and Blue. Unchecking 
allows for individual mappings. The buttons "R", "G" and "B" select for which component the map being 
edited will affect.

The "Order" option can be set to "No Order", "Increasing Order" or "Decreasing Order". Selecting "No 
Order" will allow for any mapping to be defined. Selecting "Increasing Order" will restrict mappings to 
monotonically increasing curves. Conversely, selecting "Decreasing Order will restrict mappings to 
monotonically decreasing curves. When using a "Function" to define a mapping, ImageView will set 
"Order" to "No Order".

The "Function" button will prompt the user for an expression for f(x), where x represents either the Red, 
Green or Blue component, whichever is being currently edited. If "Lock RGB" is set, the user supplied 
expression will be used for all components. When writing an expression, keep in mind that color 
components range in the closed interval [0..1]. The expression will be evaluated for discrete values in the 
range [0..1] for x, and the resulting f(x) will be truncated to [0..1]. When writing expressions for mappings, 
use the predefined variable "x" as the current component value.

Function examples: The function "x" (identity function) will map components to their current values, 
making no change on the image. The function "x^2" (x squared) will stretch the contrast for the 
component to which it is applied. Try the function "0.5-cos(x*pi)/2", for a smooth contrast edition.

The "Exec" button makes ImageView perform the changes on the image being displayed, according to 
the defined mappings. The "Ok" button will end the dialog and perpetuate changes. The "Cancel" button 
will end the dialog and restore the image as it was before the dialog began.



Palette Entry
This command is only available for 8-bit images. It will exhibit a window with all palette entries for the 
image being edited. Choose an entry and close this window with the OK button. The 24-bit color editor will 
be called to allow you to change the color for the selected palette entry. Changes will be reflected on the 
image being edited. If you are satisfied with the editing results, click on OK, otherwise click on CANCEL, 
and the palette will be remain unchanged.



Smooth Filter
This command is only available for 24-bit images. By averaging each pixel's color value with its close 
neighbors, it smooths edges and helps improve the aspect of heavily dithered images. It is a time 
consuming command, and if repeatedly applied on an image will cause excessive blurriness.



Options Menu
In the Options menu you will find commands to configure several aspects of ImageView's behavior. Your 
execution options can be saved, restored or reset default values.    The Options menu commands are 
listed below.

8-bit Bitmap 

Write 1&4 Bit Bitmaps 

Auto-resize 

Show Scroll Bars 

Thick Area Frame 

Use system colors 

Fit on load 

Place window at 

Drop to 

JPEG Options 

Slideshow Options 

Printer Options 

Contact Sheet Options 

Memory Options 

Set Background Color 

Confirm Jpeg GScale Save 

Confirm ALL Saves 

Popup When Iconized 

Load all Options 

Save all Options 

Default Options 



8-bit Bitmap
Regardless of their file format, images are translated into Windows Device Independent (DIB) format 
when loaded. ImageView can work with 8 and 24 DIBs. Set this option to make ImageView use an 8 bit 
DIB even when loading a 24 bit image. If your video card is limited to 256 colors, you can still view 24 bit 
images using 8 bit Bitmaps. When reading JPEG files (stored with 24-bit per pixel color information), 
ImageView will quantize the image according to the options you set in the JPEG Options dialog.

This option will be automatically selected if ImageView senses that your display can handle at most 8-bit 
pixel resolution (with palette references). If you then uncheck this option, ImageView will warn you that 
images will not be displayed correctly. Nevertheless, you should uncheck this option to perform format 
conversions, or image editions. This way, even if the image you see on the screen seems to have the 
"wrong" colors, image quality loss will be reduced in the process of saving edited/converted images.

The version of WECJLIB.DLL included in ImageView's package does not support 24-bit image decoding. 
You will be asked for a confirmation if you uncheck "8-bit Bitmap" and have not set "Assume ECJ pro 
version" in Options/Jpeg Options.



Write 1&4 bit Bitmaps
ImageView can process images of less than 16 colors. If you turn this option on, When you save a file to 
either Windows Bitmap or OS/2 Bitmap format, ImageView will, whenever possible, create 1 or 4 bit 
Bitmap files. If you turn this option off, only 8 or 24 bit Bitmap files will be written. The default setup for this 
option is CHECKED.



Auto-resize
Turning this option ON will make ImageView try to resize its window to the size of the image being 
displayed. If the image does not fit the maximum window size of your desktop, scrollbars may be added 
to ImageView's window. See the Show Scroll Bars command for more details.

Turning this option OFF will prevent ImageView from changing its window size. The default setup for this 
option is CHECKED.



Show Scroll Bars
Turning this option ON will make ImageView exhibit scrollbars whenever the image is larger than the 
ImageViews's client area. Turning this option OFF will prevent ImageView from exhibiting scrollbars 
whenever the image is larger than the ImageViews's client area. Scrolling will still be possible by clicking 
the left mouse button and dragging it out of the client area.

The default setup for this option is CHECKED.



Thick Area Frame
Checking this item will make ImageView exhibit a thicker boundary frame for selection areas. Thicker 
boundaries can make it easier to perform operations like moving and resizing selection areas. You can 
check and uncheck this item at anytime, and the selection area boundary will reflect the change.

The default setup for this option is UNCHECKED.



Use system colors
By default Windows reserves 20 colors from the 256 system palette entries for internal use. These colors 
are associated with menu items, captions, and other system display objects. Because of these reserved 
entries, called "static colors," when a program displays a 256 color image some of its colors may be 
"remapped" to similar colors and not exhibited exactly as they are defined in the image logical palette. A 
Windows application may reduce the number of static colors down to only 2 entries. The benefit is that the 
application will then be able to display its images in a more accurate fashion. The drawback is that all 
other applications and system items will have their colors changed.

ImageView can optionally use static color entries, and does that in an ordered way. First, ImageView 
remaps to BLACK and WHITE the colors that previously used static entries (using the 2 remaining static 
entries). This way, they remain intelligible while system colors are changed. Then, ImageView only utilizes 
the static palette entries WHILE it is the active application. This means that whenever you select another 
window, or minimize ImageView, all colors will be remapped to their original values. When ImageView's 
window is made active again, the BLACK and WHITE mapping returns, and ImageView uses all possible 
colors for displaying the current image.

Using system palette entries is not always done in a proper way. When ImageView is activated, a 
verification is made to ensure that no other application has control over static color entries. If it is found 
that these entries were not released by other applications ImageView will avoid conflicts by NOT utilizing 
system static colors. A warning message will be displayed.

Using the scheme depicted above, two or more ImageView instances are able to run concurrently, even if 
they are all set to make use of static system colors. The option "Use system colors:" will tell ImageView 
how to make use of static colors. It can be set to:

Never

Choosing this option will make ImageView preserve Windows system colors.    In general, this represents 
very little loss on image quality. (DEFAULT option setup).

While focused

Choosing this option will make ImageView use all possible palette colors ONLY while ImageView is the 
active application.    When you switch from ImageView to another application, all static system colors will 
be restored.

This option does not affect the exhibition of images in true color mode (that is, when 8-bit Bitmap is NOT 
selected), even when the image is defined in terms of palette colors, like GIF files. Also, this option does 
not affect image edition or compression quality.



Fit on load
ImageView can automatically fit loaded images to the desktop size. This is an operation equivalent to 
loading an image and then choosing the Edit/Resize command, and setting the image to "Fit the desktop" 
while preserving the aspect ratio. Except that this operation is automated, and works during ALL image 
loads, including SlideShow viewing, Batch compression, Batch printing and Clipboard pasting.

Fit on load can be set to one of the following:

Never

Choosing this option will make ImageView preserve the image size after loading it. In general, you should 
choose this option prior to batch compressing (DEFAULT setup).

to Shrink

Choosing this option will make ImageView resize images that would otherwise exceed the desktop 
maximum dimensions.

to Enlarge

Choosing this option will make ImageView resize images that would otherwise be smaller than the 
desktop maximum dimensions.

Always

Choosing this option will make ImageView resize ALL images after loading.



Place window at
ImageView can automatically position its window after loading images either from the disk or pasting from 
the clipboard.

Place window can be set to one of the following:

Same

Choosing this option will make ImageView preserve the window position after loading images. This is the 
default option. It can also be set with the accelerator key CTRL+S (DEFAULT setup).

Left & Top

Choosing this option will make ImageView reposition its window to the upper left corner of the desktop 
after loading operations. It can also be set with the accelerator key CTRL+HOME.

Left & Bottom

Choosing this option will make ImageView reposition its window to the lower left corner of the desktop 
after loading operations. It can also be set with the accelerator key CTRL+END.

Right & Top

Choosing this option will make ImageView reposition its window to the upper right corner of the desktop 
after loading operations. It can also be set with the accelerator key CTRL+PGUP.

Right & Bottom

Choosing this option will make ImageView reposition its window to the lower right corner of the desktop 
after loading operations. It can also be set with the accelerator key CTRL+PGDN.

Center

Choosing this option will make ImageView reposition its window to the center of the desktop after loading 
operations. It can also be set with the accelerator key CTRL+C.



Drop to
ImageView can automatically load a group of files, either to show them as a slideshow, to compress them 
in batch to JPEG format, to build a contact sheet image, or for printer output. Use Window's File Manager 
to select the files you wish to view, compress, merge or print, and then drag them to ImageView's window. 
If you set this option to "Slideshow," ImageView will load the files and show them successively. If you set 
this option to "Compress," the files will be compressed using the current JPEG Options. Setting this 
option to "Contact Sheet" will make ImageView merge each image file to a single image, accordingly to 
the options set on the Contact Sheet Options command. Choosing "Print" will send each one to the 
printer. To interrupt batch compression, slideshow viewing, contact sheet making or batch printing, click 
the right mouse button anywhere in ImageView's client area, or select the Menu Bar option.



JPEG Options
In this dialog you will customize JPEG decompression (for loading images) and compression (for saving 
images and batch compression) parameters. 

Decompression setup

If you enable the 8-bit Bitmap menu item, JPEG images will be quantized for display. You should not 
enable this option for batch compressions. You can set the number of quantizing passes to one or two. 
You can also turn Floyd-Steinberg dithering on/off for quantized images. For quantized images, the total 
number of colors in the generated palette is set with NColors. The best results, of course, will be obtained 
with 256 colors, but you can experiment with fewer colors. Furthermore, if you set NColors to 16 or less, 
and also set both 8-bit Bitmaps and Write 1&4 bit Bitmaps, saving the image to Windows or OS/2 DIB 
formats will produce DIBs with fewer bits per pixel, which, besides taking less disk space, can be used as 
icons. Checking the "Load GrayScale" checkbox will force JPEG images to be loaded without color 
information (only intensity).

"Load GrayScale" mode provides faster image file loading, if you are using the IJG code. This can be 
useful for image previewing.

"use ECJ DLL" when checked will make ImageView use the WECJLIB.DLL routines for FAST jpeg file 
loading. For more information about this DLL refer to WECJLIB.DLL FAST Decompression Jpeg Library. 
Unchecking this item will make ImageView use the IJG code for jpeg file loading.

"Assume ECJ pro version", when checked, tells ImageView that you are using the full version of 
WECJLIB.DLL that provides for 24-bit image decoding, and 2-pass quantizing/dithering in 8-bit mode. If 
you do not check this item, ImageView will confirm any setups that might not be supported by the free 
version of WECJLIB.DLL. "Decompression Mode" can be set to "Normal" or "Preview", allowing for two 
distinct decompression setups. The recommended usage is to set high quality image decompression 
options when "Normal" is selected, and set faster options when "Preview" is selected. The options 
dependent to "Decompression Mode" are "use ECJ", "Load Grayscale" and "8-bit Quantization".

If you are running the full version of WECJLIB.DLL you can check "use ECJ" for both "Normal" and 
"Preview" modes. This is the faster option and does not compromise image quality. If you are running the 
free version of WECJLIB.DLL (which is distributed with ImageView), you should uncheck "use ECJ" for 
"Normal" mode. The faster options are "1-pass" for "8-bit Quantization" and unchecking "Floyd-Steinberg 
Dithering". Conversely, to achieve a better quality image decompression, choose "2-pass" for "8-bit 
Quantization" and check "Floyd-Steinberg Dithering".

Compression setup

JPEG compression is "lossy". This means that the image you compress will not exactly match the original 
image. The "Quality" setting allows you to compromise between file size and compression fidelity. Set 
larger/smaller values for "Quality" to get larger/smaller files, with better/worse fidelity compared to the 
original image. In ImageView, the minimum value allowed for "Quality" is 20, and the maximum 95. When 
compressing images that have been dithered, increasing the value for "Smooth Factor" will make 
ImageView try to reduce image noise. That way you will get a smaller and (generally) better image. 
"Smooth Factor" may vary from 0 to 100, and usually a value of 20 to 50 will work fine for dithered 
images. Keep "Smooth Factor" turned off (zeroed) when saving non-dithered images. When checked, the 
"Entropy Optimization" option will make ImageView optimize JPEG compression tables, and generate 
smaller files. It will also marginally slowdown compression. When checked, the "Save GrayScale" option 
will compress the image in grayscale, regardless of its original color information. Turn this option on to 
save a grayscale image. DON'T FORGET TO TURN IT OFF AFTERWARDS. Sampling factors may be 
set to h2v2 (the default) or h2v1. Use h2v2 to obtain better compression ratios. h2v1 usually produces 
better image compression quality, at the expense of generating larger files.

The "Default Setup" button will restore the factory defaults for JPEG Options alone.



Slideshow Options
In this dialog you can customize ImageView's Slideshow behavior. Pictures can be switched automatically 
(timed), or manually. If you choose "automatic", ImageView will start to load the next Slide after the 
specified delay time. If you choose "manual", ImageView will wait until you click the left mouse button 
anywhere inside ImageView's client area to begin loading the next Slide. If you check the "Cycle 
Slideshow" checkbox, ImageView will reload the first Slide after you view the last one, and restart the 
slideshow. To interrupt the slideshow, click the right mouse button anywhere inside ImageView's client 
area. You will be prompted to confirm that you want to stop the slideshow.



Printer Options
This command will present a dialog for configuring the image output to the printer. The user can select the 
proportion for image width and height (the default, 100% for Width and Height, will print the image as it is 
seen in the display). Printouts can also be sized to fit the printer page, by checking the "Fit to Printer 
Page" checkbox.



Contact Sheet Options
 This item will open a dialog window to set the options: text font, text color, text background, image 
background and image dimensions. These options will be used when building contact sheet images.



Memory Options
This command will present a dialog for configuring memory usage. The user can choose to use only 
available main memory, or allow for temporary file creation, in a specified directory.



Set Background Color
This command will allow you to define a 24-bit color as the background color. The background color is 
used to erase the background of a selection area that is detached with a LEFT button mouse click. This 
color is also used to paint the image background of a New image, or of a Redimensioned image. When 
editing 8-bit color images, this color will be mapped to the closest palette entry of the image being edited. 
Use the Palette Entry command to see the palette colors for the image, and fix one entry to approximate 
the background color.



Confirm Jpeg GScale Save
Checking this item will make ImageView prompt for confirmation whenever saving an image to JPEG 
format, with the "Save Grayscale" option checked. The default setup for this option is CHECKED. 



Confirm ALL Saves
Checking this item will make ImageView prompt for confirmation whenever you issue the Save command. 
The default setup for this option is UNCHECKED.



Popup When Iconized
Checking this option will make ImageView restore its window whenever it loads an image file, even when 
Iconized. Unchecking will make ImageView stay as an Icon after loading images.



Load all Options
Clicking on this menu item will make ImageView reload all options from disk. Use this command if you set 
options for a particular image, and want to reset your configuration without having to reset each altered 
option individually.



Save all Options
Most of the options set by menus and/or dialogs can be altered and the new setup can be saved. Use this 
menu item to save your customized ImageView setup.



Default Options
This menu item will restore ImageView's factory defaults.



Selection Area Procedures
Selection areas are pieces of image that can be processed independently from the editing image. All 
commands in the Edit menu will act only over the current selected area, if one is defined. A selection area 
has two modes: DEFINED and DETACHED. An area is DEFINED when it is visually represented by a 
RED and WHITE rectangular boundary, and is DETACHED when it is represented by a BLUE and WHITE 
rectangular boundary. DEFINED areas can be moved, redefined and redefined. DETACHED areas can 
be moved, applied (tiled) and undefined. The sections below describe how to work with selection areas.

Creating an Area

You can define (create) a selection area by clicking and dragging the left or right mouse button anywhere 
on the editing image. While you drag the mouse, the area boundary will be displayed in red and white. 
The creation process ends when the mouse button is released. Areas with width or height less or equal to 
1 are not allowed.

Redefining an Area

You can redefine a DEFINED selection area by clicking and dragging the left or right mouse button 
anywhere on the area's boundary. Clicking on one of its sides will make the area be moved, and retain its 
dimensions. Clicking on the box at one of its vertexes will allow for resizing the area. To define an entirely 
new area, click the mouse OUTSIDE the current area boundaries, and a new area will be created.

Selection areas can also be undefined by using the command Edit/Undefine.

Detaching an Area

Once an area is DEFINED, it can be DETACHED. A DETACHED selection area may be moved around, 
and applied anywhere over the editing image. You can DETACH a DEFINED selection area by clicking 
either the LEFT or RIGHT mouse buttons INSIDE the area boundary. If you click the LEFT button, the 
selected area will be detached, and the image underneath it will be erased with the current background 
color. If you click the RIGHT button, the area will be detached, and the image will not be changed.

Once detached the selection area boundary will change from red and white to BLUE and WHITE.

Moving a Detached Area

Once an area is DETACHED, clicking and dragging anywhere inside its boundaries will make it move. 
Drag it anywhere over the editing image. By default the area boundary will not be displayed while the 
area is moved, but you can make it appear by pressing BOTH left and right mouse buttons, while 
dragging. Once you release the mouse button(s), the detached area will stop moving at the place where it 
is left.

Applying a Detached Area

Once an area is DETACHED, it can be applied (tiled) to its current position over the editing image, by 
clicking either mouse button OUTSIDE the area boundaries.

Detached areas can also be applied by selecting the menu command Edit/Apply.



Commands Window Tool
The Commands Window Tool is a separate window containing click-on bitmaps providing fast access to 
ImageView's most used features. Each bitmap, except the 2 last ones, will start a different function. The 
next to last bitmap will alternate the Commands Window Tool between the left and right sides of 
ImageView's main window. The last bitmap will reduce the Commands Window to a small button and 
place it on ImageView's main window caption bar. To restore the Commands Window Tool, just click on 
that button. Below is a list of the functions, in the order they appear in the Commands Window Tool.

File/Open

File/Save

Options/Thick Area Frame

Options/Thick Area Frame

Edit/Crop

Edit/Resize

Retouch/Contrast Enhance

Retouch/Gamma Correction

Retouch/Color Balance

Retouch/HSV Adjust

Options/Jpeg Options



WECJLIB.DLL Decompression Jpeg Library
WECJLIB.DLL is a FAST Jpeg file decompression library. The free version of this software is included in 
ImageView's package. It only does 8-bit Bitmap decompressions, and performs a single quantization 
pass. Nevertheless, it is very fast, and you will want to use it at least for image previewing.

The registered version of WECJLIB can be purchased from:

 Express Compression Laboratories, 

PO Box 367, 

Caulfield East, 

Vic 3145, Australia

 Email: ecl@werple.apana.org.au

Registration to the complete version of the program, which includes 24-bit decoding, 2-pass quantizer 
and dithering, is recommended.    The full version has excellent image quality, with no sensible loss in 
decoding speed. If you want to decode images with 2-pass quantization and dithering, or 24-bit images, 
but have not yet registered for WECJLIB's full version, you will need to uncheck the "use ECJ DLL" under 
JPEG Options.    ImageView will then use the Independent Jpeg Group's software for Jpeg 
decompression, which provides both 24-bit and 8-bit with 2-pass quantization and dithering image 
decompression.



Keyboard Accelerator Keys
ImageView uses keyboard accelerator keys to complement and speedup common operations. When a 
menu item can also be accessed via a keyboard accelerator, the corresponding key combination will be 
shown after the menu item text. The following is a list of all accelerator keys implemented on this version:

Window client area scrolling (also active while defining a region):

HOME: scrolls one page to the left

END:    scrolls one page to the right

PGUP: scrolls one page up

PGDN: scrolls one page down

UP ARROW: scrolls one line up

DOWN ARROW: scrolls one line down

LEFT ARROW: scrolls one row to the left

RIGHT ARROW: scrolls one row to the right

Common functions, also available in menu items:

SHIFT+DEL: same as Edit/Cut

CTRL+INS: same as Edit/Copy

SHIFT+INS: same as Edit/Paste

CTRL+DEL: same as Edit/Delete

CTRL+S: same as Options/Place window at:/Same

CTRL+HOME: same as Options/Place window at:/Left&Top

CTRL+END: same as Options/Place window at:/Left&Bottom

CTRL+PGUP: same as Options/Place window at:/Right&Top

CTRL+PGDN: same as Options/Place window at:/Right&Bottom

CTRL+C: same as Options/Place window at:/Center

CTRL+R: same as Edit/Resize



Image file formats
ImageView can load and save images in:

JPEG JFIF: 24 bit image format.

GIF 87a/89a: up to 8 bit image format.

Truevision TARGA: up to 24 bit image format.

Windows or OS/2 DIB format: 1, 4, 8, or 24 bit image format.

Note: RLE compressed DIBs are not supported.



Calculator
ImageView has an internal "calculator" to evaluate user defined expressions. In this version, calculator 
usage is restricted to the Interactive RGB Command, but in future versions its usage will be spread to 
other advanced image editing functions. The calculator is a simple, yet powerful expression interpreter. It 
works on C-like expressions and provides operators, built in "scientific functions" and the predefined 
constants: "e" (base for the Napierian logarithms) and "pi" (3.1415...).

Calculator functions (all trig functions work in radians):

logarithm of x on base b: Log (x, b)

Napierian logarithm of x: Ln (x)

Exponential of x (e^x): Exp (x)

Sine of x: Sin (x)

Cosine of x: Cos (x)

Tangent of x: Tan (x)

Cotangent of x (1/tan(x)): Cotg (x)

Secant of x (1/cos(x)): Sec (x)

Cosecant of x (1/sin(x)): Cosec (x)

Arc for which tangent == x: Atan (x)

Arc for which sin == x: Asin (x)

Arc for which cos == x: Acos (x)

absolute (positive) value of x: Abs (x)

Hyperbolic sine of x: Sinh (x)

Hyperbolic cosine of x: Cosh (x)

Hyperbolic tangent of x: Tanh (x)

Calculator operators:

for add, subtract, multiply, divide, raise and module:    +    -    *    /    ^    %

for grouping: ( )

the usual comparison operators:    ==    !=    >    >=    <    <=

logical AND and OR:    &&    ||

C-like ternary operator:    ?:

Example expressions:

x ^ 0.8 + sin (x), will return x raised to 0.8 plus the sine of x

x < 0.5 ? x : 0.5 - cos (x * pi) / 2, will return x if x < 0.5, otherwise

will return the result of 0.5 - cos (x * pi) / 2.

x == 0.5 || (x < 0.25 && x > 0.1) ? 1 : x, will return x, except for values of x in the range (0.1 .. 0.25) or x 
equal to 0.5. For these latter values, the returned value will be 1.

 




